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The TRIUS SX-825 mono CCD camera  

 

 
 

 
The TRIUS SX-825 is an advanced, high resolution, cooled CCD camera, especially designed for 
astronomical imaging. It uses a second generation version of the very popular Sony ‘EXview II’ CCDs 
that offer very high QE and extremely low thermal noise. It is a substantial upgrade on the SXVR 
camera range and incorporates several new features, such as an internal USB hub with 3 external ports 
and a dry argon CCD chamber fill. The USB hub permits several other devices to share the single USB 
connection and greatly reduces the number of cables required in a typical set-up. For example, a 
Lodestar or Superstar guide camera and an SX filter wheel could use two of the USB ports and the 
third might connect to an electric focuser, or similar peripheral. The argon fill, along with other 
improvements to the cooler stack, has improved the delta T to about -42 degrees C. 
As per the SXVR range, this camera also includes a CCD temperature monitoring circuit that provides 
regulated set-point cooling of the chip, adjustable chip alignment and a very compact overall size. 
 
The TRIUS SX-825 uses a Sony ICX825AL ‘EXview II’ progressive scan CCD, with 1392 x 1040 x 
6.45uM pixels in a 8.8 x 6.3mm active area. This EXview II device has an excellent quantum 
efficiency, with a broad spectral response peaking at around 77% in yellow light, and an extremely low 
dark current, well below that of any comparable CCD currently available. While this device also has an 
excellent blue light sensitivity, it has a strong infra-red response, which makes it ideal for all aspects of 
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both planetary and deep-sky imaging, especially with an H-alpha filter. The H-alpha QE is about 65%, 
considerably better than other interline chips and even greater than the popular KAF8300 CCD. 
 
The full-frame download time is approximately 4 seconds and a binned 4x4 download takes only 0.5 
seconds, so finding and centring are very quick and easy in this mode.  
 
Here is a diagram of the connectors to be found on the rear panel of the camera: 
 

 
 
Please take a few minutes to study the contents of this manual, which will help you to get the camera 
into operation quickly and without problems. I am sure that you want to see some results as soon as 
possible, so please move on to the ‘Quick Start’ section, which follows. A more detailed description of 
imaging techniques will be found in a later part of this manual. 
 

 
 
 
 

‘Quick Starting’ your TRIUS SX-825 system 
 
Please note, the TRIUS SX-825 is the successor to the TRIUS SX-9. The drivers and file formats 
are identical so within our software and other third party software, your SX-825 camera will be 
identified as an H9 or SX-9 derivative.  
 
In the shipping container you will find the following items: 
 

1) The TRIUS SX-825 camera head. 
2) A universal AC power supply module. 
3) A USB camera cable. 
4) An adaptor for 1.25” drawtubes, with a 1.25” filter thread. 
5) An adaptor for 2” drawtubes and M42 Pentax thread lenses. 
6) A guider output to guider port RJ12 lead. 
7) Three short USB leads for connecting to the hub ports. 
8) A 'Y' power lead for connecting the cooling fan. 
9) A disk with the TRIUS Monochrome Camera Control Software and SX-825 manual. 
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You will also need a PC computer with Windows XP, Vista or Windows 7 installed. This machine 
must have at least one USB 2.0 port available and at least 256 Mbytes of memory. If you intend to 
view the finished images on its screen, then you will also need a graphics card capable of displaying an 
image with a minimum of 1024 x 768 pixels and 24 bit colour. A medium specification Pentium with 
between 1GHz and 4GHz processor speed is ideal, but I recommend avoiding some of the lower 
specification ‘Netbook’ computers, as they can’t really handle the fast data stream from the camera. 
Please note that USB 2.0 operates at a very high speed and cannot operate over very long cables. Five 
metres of good quality cable is the maximum normally possible without boosters or extra powered 
hubs, although you can sometimes get good results at longer distances with very high quality cables.  
 
 
Installing the USB system: 
 
First, find a free USB socket on your PC and plug in the USB cable (do not connect the camera at this 
time). If you do not have a USB2 capable computer, it is normally possible to install a USB 2 card into 
an expansion slot.  
 
The next operation is to run the software installer from the CD ROM provided. Insert the CD into the 
computer and wait for Windows Explorer to open with the list of folders on the ROM. Now run the 
SETUP.EXE file that it contains – this will initiate the self-install software which will guide you 
through the process of installing the SX camera software onto your computer.  
 
Now connect the USB cable to the socket on the camera rear panel.  
 

 
 
 
Windows will report ‘Found new hardware’ and will ask for the location of the drivers. Point the 
installer at the appropriate driver folder on your CD ROM (32 bit or 64 bit) - note that the ‘Windows 8 
signed drivers’ are OK for Windows 8, Windows 7 and Vista, but not for Windows XP. Use the older 
32 or 64 bit drivers for XP machines. Once you select the correct driver package, the driver installation 
should proceed smoothly. (Ignore any warnings about the older drivers having not been tested by 
Microsoft).  
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At the end of this process, the USB interface will be installed. The XP drivers will show up as a 
‘BlockIOClass device’ and the camera software will be able to access it. You can confirm that the 
installation is complete by checking the status of the USB devices in the Windows ‘Device Manager’ 
(see above). Start up the Windows ‘Control Panel’ and select ‘System’. Now click on the tab labelled 
‘Device Manager’, ‘Hardware’, and all of the system devices will be displayed in a list (see above). If 
the installation is successful, there will be a diamond shaped symbol labelled ‘BlockIOClass’ and 
clicking on the ‘+’ sign will reveal it to be a ‘Starlight Xpress USB 2.0 SXV-SX9 BlockIO camera 
driver’. If this device shows as faulty, try clicking on it and selecting ‘properties’ and then ‘update 
driver’. Following the on screen instructions will allow you to re-select the correct inf file from the CD 
(SXVIO_SX9_119.inf) and driver files (SXVIO.sys and generic.sys), which should fix the problem. 
 
The newer ‘Signed’ drivers create a device in the ‘USB’ section of the devices list and this will be 
found at the bottom of the device manager window. 
 

 
 
Now connect up the power supply and switch it on. The supply is a very efficient ‘switch mode’ unit, 
which can operate from either 110v or 220v AC via an appropriate mains power cable (supplied). You 
can now start the software by double clicking on the icon, when you should see the main menu and 
image panel appear. If this is the first time that it has been run, you will receive a warning about the 
lack of an ‘ini’ file – just click on ‘OK’ and then open ‘Set program defaults’ from the ‘File’ menu. In 
the bottom right hand corner of this box, select SXV-SX9. Now click on ‘Save’ and the ini file will be 
created and the software set for your camera. 
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Now click on the camera icon at the top of the screen. If the USB connection is OK, a message box will 
inform you of the ‘Handle’ number for the SXVIO interface and various other version details etc. Click 
‘OK’ and the main camera control panel will now be seen. 
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As can be seen above, there is a CCD temperature monitoring window at the right hand side of the 
panel. At switch-on, this will default to full power cooling with an end point of -40C (actual chip 
temperature) and, needless to say, this is rather extreme. I recommend changing the set point to about -
10C for normal use, but you can go much colder if you are imaging during the winter months. Under 
indoor conditions, the low airflow will limit the cooling capability, and you should use a set point of no 
lower than -5C for stable cooling. You can determine the optimum settings for your camera and 
ambient conditions when you have some experience of using the system, but do not try to operate at 
extreme cooling when the air temperature is high. Connecting and using the external fan unit will 
improve the cooling by at least -5C and can give as much as -10C extra delta T. It is connected by 
using the 'Y' lead provided in the camera component set, as below: 
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Recording your first image: 
 
We now have the camera and computer set up to take pictures, but an optical system is needed to 
project an image onto the CCD surface. You could use your telescope, but this introduces additional 
complications, which are best avoided at this early stage. There are two simple options, one of which is 
available to everyone with a sheet of aluminium baking foil:  
 
1) Attach a standard ‘M42’ SLR camera lens to the TRIUS SX-825, using the 26mm spacer to 

achieve the correct focal distance.  
 

 
 
Or 
 
2) Create a ‘Pin hole’ lens by sticking a sheet of aluminium baking foil over the end of the adaptor 

and pricking its centre with a small pin. 
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If you use a normal lens, then stop it down to the smallest aperture number possible, (usually F22), as 
this will minimise focus problems and keep the light level reasonable for daytime testing. The pin hole 
needs no such adjustments and will work immediately, although somewhat fuzzily!  
 
Point the camera + lens or pinhole towards a well-lit and clearly defined object some distance away. 
Now enter the ‘File’ menu in the SX-825 software and click on ‘SX camera interface’. Select an 
exposure time of 0.1 seconds and press ‘Take Photo’. 
 
After the exposure and download have completed (about 4 seconds) an image of some kind will appear 
on the computer monitor. It will probably be poorly focused and incorrectly exposed, but any sort of 
image is better than none! In the case of the pinhole, all that you can experiment with is the exposure 
time, but a camera lens can be adjusted for good focus and so you might want to try this to judge the 
high image quality that it is possible to achieve.  
 
Various other exposure options are available, as can be seen in the picture above. For example, you can 
‘Bin’ the download 2x2, or more, to achieve greater sensitivity and faster download, or enable 
‘Continuous mode’ to see a steady stream of images. ‘Focus mode’ downloads a 128 x 128 segment of 
the image at high speed. The initial position of the segment is central to the frame, but can be moved by 
selecting ‘Focus frame centre’ in the ‘File’ menu and clicking the desired point with the mouse. The 
focus window has an adjustable ‘contrast stretch’, controlled by the 12-16 bit slider. The image will be 
‘normal’ if 16 bits is selected, while setting lower values will increase the image brightness in inverse 
proportion. 
 
If you cannot record any kind of image, please check the following points: 
 
1) Ensure that the power indicator lamp is on and that the cables are properly home in their sockets. 
2) If the screen is completely white, the camera may be greatly overexposed. Try a shorter exposure 

time, or stop down your lens. See if covering the lens causes the image to darken. 
3) If the USB did not initialise properly, the camera start-up screen will tell you that the connection is 

defective. Try switching off the power supply and unplugging the USB cable. Now turn the power 
supply on and plug in the USB cable. This will re-load the USB software and may fix the problem 
after restarting the SXV_hmf_usb program. Otherwise, check the device driver status, as 
previously described, and re-install any drivers which appear to be defective.  

4) If you cannot find any way of making the camera work, please try using it with another computer. 
This will confirm that the camera is OK, or faulty, and you can then decide how to proceed. Our 
guarantee ensures that any electrical faults are corrected quickly and at no cost to the customer. 

 
 
Image enhancements: 
 
Your first image may be satisfactory, but it is unlikely to be as clear and sharp as it could be. Improved 
focusing and exposure selection may correct these shortcomings, and you may like to try them before 
applying any image enhancement with the software. However, there will come a point when you say, 
“That’s the best that I can get” and you will want to experiment with the effects of image processing. In 
the case of daylight images, the processing options are many, but there are few that will improve the 
picture in a useful way. The most useful of these are the ‘Normal Contrast Stretch’ and the ‘High Pass 
Low Power’ filter. The high pass filter gives a moderate improvement in the image sharpness, and this 
can be very effective on daylight images.  
 
Too much high pass filtering results in dark borders around well-defined features and will increase the 
noise in an image to unacceptable levels, but the Low Power filter is close to optimum and gives a 
nicely sharpened picture. 
 
The ‘Contrast’ routines are used to brighten (or dull) the image highlights and shadows. A ‘Normal’ 
stretch is a simple linear operation, where two pointers (the ‘black’ and ‘white’ limits) can be set at 
either side of the image histogram and used to define new start and end points. The image data is then 
mathematically modified so that any pixels that are to the left of the ‘black’ pointer are set to black and 
any pixels to the right of the ‘white’ pointer are set to white. The pixels with values between the 
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pointers are modified to fit the new brightness distribution. Try experimenting with the pointer 
positions until the image has a pleasing brightness and ‘crispness’. 
 
At this point, you will have a working knowledge of how to take and process an TRIUS SX-825 image. 
It is time to move on to astronomical imaging, which has its own, unique, set of problems! 
 
 
 
 
 
 
********************************************************************* 

Astronomical Imaging with the TRIUS SX-825 
 

1) Getting the image onto the CCD: 
 
It is fairly easy to find the correct focus setting for the camera when using a standard SLR lens, but 
quite a different matter when the TRIUS SX-825 is attached to a telescope! The problem is that most 
telescopes have a large range of focus adjustment and the CCD needs to be quite close to the correct 
position before you can discern details well enough to optimise the focus setting. An additional 
complication is the need to add various accessories between the camera and telescope in order that the 
image scale is suitable for the subject being imaged and (sometimes) to include a ‘flip mirror’ finder 
unit for visual object location. 
A simple, but invaluable device, is the ‘par-focal eyepiece’. This is an eyepiece in which the field stop 
is located at the same distance from the barrel end, as the CCD is from the camera barrel end.  
 

 
 
When the par-focal eyepiece is fitted into the telescope drawtube, you can adjust the focus until the 
view is sharply defined and the object of interest is close to the field centre. On removing the eyepiece 
and fitting the CCD camera, the CCD will be very close to the focal plane of the telescope and should 
record the stars etc. well enough for the focus to be trimmed to its optimum setting 
 
Several astronomical stores sell adjustable par-focal eyepieces, but you can also make your own with a 
minimum of materials and an unwanted Kellner or Plossl ocular.  
Just measure a distance of 22mm from the field stop of the eyepiece (equivalent to the CCD to adaptor 
flange distance of the camera) and make an extension tube to set the field stop at this distance from the 
drawtube end. Cut-down 35mm film cassette containers are a convenient diameter for making the 
spacer tube and may be split to adjust their diameter to fit the drawtube. 

 
It is necessary to set up a good optical match between your camera and the telescope. Most SCTs have 
a focal ratio of around F10, which is too high for most deep sky objects and too low for the planets! 
This problem is quite easy to overcome if you have access to a focal reducer (for deep sky) and a 
Barlow lens for planetary work. The Meade F6.3 focal reducer is very useful for CCD imaging and I 
can recommend it from personal experience. It does not require a yellow filter for aberration correction, 
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unlike some other designs, so it can also be used for tri-colour imaging. If you use a focal reducer, 
using it at maximum reduction may cause the relatively large chip of the TRIUS SX-825 to suffer from 
considerable ‘vignetting’ (dimming towards the corners) and this will be difficult to remove from your 
images. Experiment with the distance between the reducer and the camera to optimise the results. The 
longer the extension tube used, the greater the focal reduction will be. As a guide, most CCD 
astronomers try to maintain an image scale of about 2 arc seconds per pixel for deep sky images. This 
matches the telescope resolution to the CCD resolution and avoids ‘undersampling’ the image, which 
can result in square stars and other unwanted effects. To calculate the focal length required for this 
condition to exist, you can use the following simple equation: 
 

F = Pixel size * 205920 / Resolution (in arc seconds) 
 

In the case of the TRIUS SX-825 and a 2 arc seconds per pixel resolution, we get  
 

F = 0.00454 * 205920 / 2  = 467mm 
 

For a 200mm SCT, this is an F ratio of 467 / 200 = F2.34, which is much less than can be achieved 
with the Meade converter and appropriate extension tube. However, moderate deviations from this 
focal length will not have a drastic effect and so any F ratio from about F4.5 to F6.3 will give good 
results. It is clear from this result that the ‘Starizona Hyperstar’ adaptor is very well suited to use with 
the SX9, as it operates at around F1.95, so you might be interested in getting one of these. 
 
The same equation can be used to calculate the amplification required for good planetary images. 
However, in this case, the shorter exposures allow us to assume a much better telescope resolution and 
0.25 arc seconds per pixel is a good value to use. The calculation now gives the following result: 
 

F = 0.00545 * 205920 / 0.25 = 4489mm 
 

This is approximately F22 when used with a 200mm SCT and so we will need a 2 or 3x Barlow lens. 
Barlow lenses are less critical than focal reducers and most types can be used with good results. 
However, if you are buying one especially for CCD imaging, I recommend getting a 3x or even 5x 
amplifier, or the planets will still be rather small in your images. 
 
Achieving a good focus: 
 
Your starting point will depend on the focus aids, if any, which you are using. With the par-focal 
eyepiece, you should slip the eyepiece into the drawtube and focus visually on a moderately bright star 
(about 3rd magnitude). Now withdraw the eyepiece and carefully insert the camera nosepiece, until it is 
bottomed against the drawtube end, and then lock it in place.  
 
SXV_hmf_usb.exe has a focus routine that will repeatedly download and display a 128 x 128 pixel 
segment of the image at relatively high speed. This focus window may be positioned anywhere in the 
camera field and can be displayed with an adjustable degree of automatic contrast stretching (for 
focusing on faint stars). To use this mode, start up the software and select the SXV camera interface 
(File menu). Set the camera mode to Binned 1x1 and select an exposure time of 1 second. Press ‘Take 
Picture’ and wait for the image to download. There is a good chance that your selected star will appear 
somewhere within the image frame and it should be close to a sharp focus. If the focus is still poor, 
then it may appear as a pale disk of light, often with a dark centre (the secondary mirror shadow in an 
SCT, or Newtonian). Now select the ‘File’ menu again and click on ‘Focus frame centre’; you can now 
use the mouse pointer to click on the star image and the new focus frame co-ordinates will be 
displayed. Now return to the camera interface window and click on ‘Start’ in the Focus frame. The 
computer will now display a continuous series of 128 x 128 pixel images in the focus window and you 
should see your selected star appear somewhere close to the centre. A ‘peak value’ (the value of the 
brightest pixel) will also be shown in the adjacent text box and this can be used as an indication of the 
focus accuracy. Although the peak value is sensitive to vibration and seeing, it tends towards a 
maximum as the focus is optimised. Carefully adjust the focus control on your telescope until the 
image is as sharp as possible and the peak value reaches a maximum. Wait for any vibration to die 
down before accepting the reading as reliable and watch out for bursts of bad seeing, which reduce the 
apparent focus quality. Quite often, the peak value will increase to the point where it is ‘off scale’ at 
4095 and in this case you must halt the focus sequence and select a shorter exposure if you wish to use 
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the peak value as an indicator. Once you are happy with the focus quality achieved, you might like to 
trim the settings of your par-focal or flip mirror eyepiece to match the current camera position. 
Although you can reach a good focus by the above method, many observers prefer to use additional 
aids, such as Hartmann or Bahnitov masks (an objective cover with several spaced holes) or diffraction 
bars (narrow parallel rods across the telescope aperture). These make the point of precise focus easier 
to determine by creating ‘double images’ or bright diffraction spikes around stars, which merge at the 
setting of exact focus. The 12-16 bit slider control allows you to adjust the contrast of the focus frame 
for best visibility of the star image. It defaults to maximum stretch (12 bits), which is generally ideal 
for stars, but a lower stretch value is better for focusing on planets. 
 
Taking your first astronomical image: 
 
I will assume that you are now set up with a focused camera attached to a telescope with an operating 
sidereal drive. If so, you are now in a position to take a moderately long exposure of some interesting 
deep-sky astronomical object (I will deal with planets later). As most drives are not very accurate 
beyond a minute or two of exposure time, I suggest that you find a fairly bright object to image, such as 
M42, M13, M27 or M57. There are many others to choose from, but these are good examples. 
 
Use the finder to align on your chosen object and then centre accurately by using the focus frame and a 
short exposure of between 1 and 5 seconds. The ’12-16 bit’ slider in the focus frame allows you to 
adjust the image contrast if you find that the object is too faint with a short exposure. Once properly 
centred and focused, take an exposure of about 60 seconds, and observe the result. Initially, the image 
may appear rather barren and show only a few stars, however, there is a great deal of data hidden from 
view. You can get to see a lot of this, without affecting the image data, if you go to the ‘View’ menu 
and select ‘Auto Contrast Stretch Image’. The faint image data will then appear in considerable detail 
and I think that you will be impressed by the result! 
 
If you are happy with the image, go to the ‘File’ menu and save it in a convenient directory.  
 
Most competitive brands of CCD camera require a ‘dark frame’ to be subtracted from your images to 
achieve the best results. A dark frame is simply a picture which was taken with the same exposure as 
your ‘light frame’, but with the telescope objective covered, so that no light can enter. It records only 
the ‘hot pixels’ and thermal gradients of your CCD, so that these defects are largely removed when the 
dark frame is subtracted from the light frame. The TRIUS SX-825 CCD is quite different from those 
used in other brands of camera and generates an extremely low level of dark noise. Indeed, it is so low 
that subtracting a dark frame can actually INCREASE the noise in your images! This is because the 
statistical noise of the dark frame can exceed the ‘pattern noise’ from warm pixels and hence add to 
that of the subtracted result. If your test pictures have an exposure time of less than about 10 minutes 
(as above), then don’t bother with a dark frame, just ‘kill’ any hot pixels with your processing software. 
In TRIUS SX-825, the ‘Median filter’ can do this, but other software (e.g. Maxim DL) will provide a 
‘hot pixel killer’ that can be mapped to specific locations in the image, or methods such as ‘Sigma 
combine’ may be used.  
 
In the unlikely event that you feel that dark frame really is necessary, please proceed as follows: 
 
To take a dark frame, just cover the telescope objective with the lens cap and take another exposure 
with the same length as that of the light frame. This image will be a picture of the dark signal generated 
during your exposure and it should be saved with your image for use in processing the picture. If many 
such darks are recorded and averaged together, the statistical noise will be reduced, but the gains to be 
had are rather small compared with the effort involved.  
 
As variations in ambient temperature will affect the dark signal, it is best to take the dark frames within 
a few minutes of capturing your images. For the same reason, it is not wise to use ‘old’ dark frames if 
you want the best possible results, however, some software allows you to scale library dark frames to 
match the image (e.g. AstroArt) and this can be useful as a time saver. 
 
‘Bias frames’ are somewhat more useful than dark frames when using the TRIUS SX-825. A bias 
frame is essentially a zero exposure dark frame and records any minor readout defects that the CCD 
may possess, so a ‘bias frame subtraction’ can clean up any ‘warm columns’ or shadings that are 
created during readout. To record a bias frame, cover the camera aperture and take a 1000th of a second 
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exposure. If you take at least 10 such frames and average them together, the resulting ‘master bias’ can 
be used to clean up readout defects for many months before CCD ageing changes require another set to 
be recorded. 
  
‘Flat fields’ are often recommended for optimising the results from your CCD camera, but these are 
generally less important than dark frames, especially if you make sure that the optical window of the 
camera is kept dust-free. The purpose of a flat field is to compensate for uneven illumination and 
sensitivity of the CCD and it is better to avoid the need for one by keeping the optics clean and 
unvignetted. I will ignore flat fielding for current purposes and describe the process in detail at a later 
stage. 
 
Processing a deep-sky image: 
 
1) Make sure the ‘Auto Contrast Stretch’ is switched off and load your image into SXV_hmf_usb. If 
you intend to subtract a dark frame, select ‘Merge’ and then ‘Subtract Dark Frame’. Pick the 
appropriate dark frame and the software will then remove the dark signal from your image, leaving it 
somewhat darker and slightly smoother than before.    
 

 
M42 – 30 seconds exposure at F2 with a C8 Hyperstar 

 
2) Once you have subtracted any dark frame, you can convert the raw image to colour. 
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3) The resulting image will probably look faint and dull, possibly with a pale yellowish background, 
due to light pollution so it is now time to process the ‘luminance’ (brightness and contrast) of the image 
to get the best visual appearance. First, use the ‘Normal’ contrast stretch to darken the background by 
setting the ‘Black’ slider just below the main peak of the histogram. Alternatively, you can use the 
‘Remove Background’ option to let the software decide on the best setting. This will greatly reduce the 
background brightness and the image will begin to look rather more attractive, although dark. You can 
now try brightening the highlights with another ‘Normal’ stretch, in which you bring down the ‘White’ 
slider to just above the main image peak. The best setting for this is rather more difficult to guess and 
you may need several attempts before the result is ideal. Just use the ‘Undo last filter’ function, if 
necessary, to correct a mistake. Normal (linear) stretches can give a nice result on many objects, but 
you may find that bright areas ‘burn-out’ badly with this function. It is often much better to use a ‘Non-
linear’ stretch to compress the brighter regions, while expanding the faint data. Here is the result of a 
non-linear stretch on the M42 image: 
 



Handbook for the TRIUS SX-825      Issue 1 January 2015 
 

 14 

 
 

 
The image now looks quite impressive and I hope that you like this result from this simple processing.  
 
Further small refinements are usually possible and you will become expert at judging the best way to 
achieve these as your experience increases. As a rough guide, the ‘Filters’ menu can be used to 
sharpen, soften or noise reduce the image. Strong ‘High Pass’ filters are usually not a good idea with 
deep sky images, as the noise will be strongly increased and dark rings will appear around the stars, but 
a ‘Median’ filter can remove odd speckles and a mild ‘Unsharp Mask’ (Radius 3, Power 1) will sharpen 
without too much increase in noise. 
 
Other things to try, include summing several images for a better signal to noise ratio. Summing can be 
done in the ‘Merge’ menu and involves loading the first processed image, selecting a reference point (a 
star) then loading the second image and finding the same star with the mouse. Once the reference is 
selected, you can either add directly, or average the images together. Averaging is generally better, as 
you are less likely to saturate the highlights of the picture. The signal-to-noise ratio will improve at a 
rate proportional to the square root of the number of summations (summing 4 images will double the 
signal-to-noise), but different exposures must be used. Summing an image with itself will not improve 
the S/N ratio. Also note that you cannot sum images before colour conversion, or the colour data will 
be destroyed! 
 
Although I have concentrated on the use of a telescope for deep-sky imaging, do not forget that you 
have the option of using an ordinary camera lens for impressive wide-field shots! A good quality 
200mm F3.5 lens with an infrared blocking filter will yield very nice images of large objects, such as 
M31, M42, M45 etc. If you cannot obtain a large IR blocker for the front of the lens, it is quite 
acceptable to place a small one behind the lens, inside the adaptor tube. You can even try using a 
hydrogen-alpha filter to bring out nebulae, reduce light pollution and sharpen the star images to pin-
points. 
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Taking pictures of the planets: 
 
Planetary imaging is in many ways quite different from deep sky imaging. Most deep sky objects are 
faint and relatively large, so a short focal length and a long exposure are needed, while planets are 
bright and very small, needing long focal lengths and short exposures. High resolution is critical to 
achieving good results and I have already shown how a suitable focal length can be calculated and 
produced, using a Barlow lens. 
 
Many camera users comment on the difficulty of finding the correct focus when taking pictures of 
Jupiter etc. This is usually due to poor seeing conditions, which are only too common, but may also be 
due in part to poor collimation of your telescope. Please ensure that the optics are properly aligned as 
shown by star testing, or by using one of the patent collimation aids that are widely available. It is also 
better to use a star for initial focusing, as planetary detail is difficult to judge in bad seeing. Although 
the star will also suffer from blurring, the eye can more easily gauge when the most compact blur has 
been achieved! 
 
You could begin by imaging lunar craters, or the planets, Jupiter, Saturn or Mars. The rapid variations 
of seeing which accompany planetary imaging, will ruin the definition of about 95% of your images 
and so I recommend setting the camera to run in ‘Autosave’ mode. This will automatically take a 
sequence of images and save them with sequential file names in your ‘Autosave’ directory. Dozens of 
images will be saved, but only one or two will be satisfactory for further processing. The ‘Subframe’ 
mode of the SXV may be found useful for limiting the wasted area and reducing the download time of 
small planetary images. 
 
To start the Autosave process, call up the SXV Camera Interface and select the ‘Continuous Mode’ 
check box at the top (make sure the rest are unchecked). Now check the ‘Autosave Image’ checkbox 
near the bottom of the window. If you now click on ‘Take Picture’ the automatic sequence will begin 
and will not stop until you press a computer key. The images will be saved in FITs format with 
sequential names such as ‘Img23, Img24….’ and will be found in the ‘Autosave’ directory (or a sub-
directory of Autosave, set up in the program defaults menu).  
 
The exposure time needed for good planetary images is such that the image histogram has a peak value 
at around 200 and does not extend much above 220 (Ignore the major peak near zero, due to the dark 
background). If you use too short an exposure time, the image noise level will be increased, and if too 
long a time is used you will saturate the highlights and cause white patches on the image. With the 
recommended focal length, Jupiter and Mars will both need an exposure time of between 0.1 and 1 
seconds and Saturn will need between 0.5 and 2 seconds. 
 
Processing a planetary image: 
 
Planetary images have one major advantage over deep sky images, when you come to process them – 
they are MUCH brighter, with a correspondingly better signal to noise ratio. This means that aggressive 
sharpening filters may be used without making the result look very noisy and so some of the effects of 
poor seeing can be neutralised. 
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A raw image 

 
Try applying an ‘Unsharp Mask’ filter with a radius of 5 and a power of 5. This will greatly increase 
the visibility of any detail on the planet, but the optimum radius and power will have to be determined 
by experiment.  

 

 
 

After conversion and the application of an ‘Unsharp mask’ 
 

In general terms, the larger the image and the worse the seeing, then the wider the radius for best 
results. My Jupiter shots are usually about one third the height of the CCD frame and I find that the 
‘radius 5, power 5’ values are good for most average seeing conditions. If you have exceptionally good 
conditions, then a reduction to R=3, P=3 will probably give a more natural look to the image, as too 
large a radius and power tends to outline edges with dark or bright borders.  
 
As a finishing touch, the application of a Median filter or a Weighted Mean Low Pass filter can be 
useful to smooth out the high frequency noise after a strong Unsharp Mask. 

 
As with deep-sky images, it is advantageous to sum planetary images together to improve the signal to 
noise ratio. In this case, the ‘averaging’ option should always be used, or the result is likely to exceed 
the dynamic range of the software and saturate the highlights. Aligning the images is always something 
of a problem, as there are rarely any stars to use when imaging the planets, but Jupiter’s satellites can 
be useful reference points. Otherwise, you will have to find a well-defined feature on the planet, or 



Handbook for the TRIUS SX-825      Issue 1 January 2015 
 

 17 

estimate where the centre of the disk is located. Some more sophisticated software can automatically 
align planetary images and you may find these programs (e.g. ‘Registax’) to be very useful. 
 
 
********************************************************************* 

 
Other features of the TRIUS SX-825 hardware and software 

 
 

‘Slew & Sum’ imaging: 
 
The TRIUS SX-825 can be used in an automatic image-stacking mode, called ‘Slew & Sum’. The 
camera is set to take several sequential exposures, which are automatically ‘slewed’ into alignment and 
then summed together by the software. This mode can help to overcome a poor RA drive by summing 
images that have exposure times shorter than the drive error period. The resulting image has more noise 
than a single exposure of the same total length, but this method of imaging is still an effective way of 
making long exposures without a guider. 
 
To take an S&S image, go to the camera interface window and select an exposure time for one image 
of the sequence. Do not use a very short exposure time, as the read-out noise will become dominant. 
About 30 seconds is a reasonable minimum. Now go to the ‘Multiple Exposure Options’ and select a 
number of exposures to take. You can also select to average the images, rather than adding them, and 
there is a ‘Alternative Slew Mode’ available, which uses the correlation of image areas, rather than a 
single star. This mode can be better in dense star fields.  
Another option is ‘Auto remove dark frame’. This is advisable with S&S images, as the slewing will 
mis-register the images with a single dark frame that is applied to the finished sequence. To use this 
option, you will need a dark frame, taken with the same exposure time as a single image from the 
sequence. This is stored on drive C with the name ‘dark.def’  
 
Now click on ‘Take Picture’ and the sequence will begin. 
 
Using the ‘Binned’ modes: 
 
Up to this point, I have assumed that the full resolution, imaging mode is being used. This is fine for 
most purposes, but it will often provide more resolution than the optical system, or the seeing, allows. 
‘Binned 2x2’ mode sums groups of 4 pixels into one output pixel, thus creating a pixel image with 4 
times the effective sensitivity. Using 2x2 binning, you can considerably improve the sensitivity of the 
TRIUS SX-825 without losing a great deal of resolving power, so you may like to use this mode for 
many faint deep-sky objects. Other binning modes (3x3 and 4x4) are available and will further increase 
the image brightness and reduce its resolution. However, generally, these are more useful for finding 
faint objects, than for imaging. 
 
Taking and using a flat field: 
 
Flat fields are images, which display only the variations of illumination and sensitivity of the CCD and 
are used to mathematically modify a wanted image in such a way that the errors are removed. Common 
flat field errors are due to dust motes on the camera window and vignetting effects in the optical system 
of the telescope. Dust motes act as ‘inverse pinholes’ and cast out-of-focus images of the telescope 
aperture onto the CCD chip, where they appear as shadow ‘do-nuts’. Most optical systems show some 
vignetting at the edges of the field, especially when focal reducers are used. This causes a brighter 
centre to show in images, especially when there is a lot of sky light to illuminate the field. 
 
If dust motes are your main problem, it is best to clean the camera window, rather than to rely on a flat 
field to remove the do-nuts. Flat fields always increase the noise in an image and so physical dust 
removal is the best option. If you have serious vignetting, first check whether the optical system can be 
improved. The most likely cause of this problem is trying to use too powerful a degree of optical 
compression with a focal reducer and you might want to try moving the camera closer to the reducer 
lens. 
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If you really do need to use a flat field for image correction, then it must be taken with care. It is most 
important that the optical system MUST NOT be disturbed between taking your original images and 
taking the flat field. Any relative changes of focus and rotation etc. will upset the match between flat 
field and image and the result will be poor correction of the errors. The other necessity for recording a 
good flat field is a source of very even illumination of the telescope field. This is surprisingly difficult 
to achieve and many designs of light source have appeared in the literature and on the Web. These 
usually consist of a large wooden box, containing several lamps and an internal coating of matt white 
paint, which is placed over the objective of the telescope to provide an evenly illuminated surface. 
These can work well, but I prefer a simpler method, as follows: 
 
Most imaging sessions begin or end in twilight and so the dusk or dawn sky can provide a distributed 
source of light for a flat field. However, using the sky directly is likely to result in recording many 
unwanted stars, or patches of cloud etc., so a diffuser needs to be added to the telescope. An ideal 
material is Mylar plastic drafting film, obtained from an office supplies warehouse. It is strong and 
water resistant and can be easily replaced if damaged. Stretch a piece of the film loosely across the 
aperture of your telescope and point the instrument high in the sky, to avoid any gradient in the light 
near the horizon. Now take several images with exposure times adjusted to give a bright, but not 
overloaded, picture. A histogram peaking at around 128 is ideal. Averaging flat fields together is a 
good way to reduce their noise contribution and so recording 4, or more, images is a good idea. 
 
To use your flat fields, they must first have a dark frame subtracted. Although this may appear to be 
unimportant with such brightly lit and short exposures, there is the ‘bias offset’ of the camera in each 
image and this can produce an error in the final correction. As we are mainly interested in the bias, any 
very short exposure dark frame will give a good result. The dark subtracted images should then be 
averaged together before use.  
 
After the above procedures have been executed, the flat field will be ready for use. Load up your image 
for processing, subtract the dark frame and then select ‘Apply flat field’ in the ‘Merge’ menu. The 
result should be an image with very few signs of the original artefacts and you can then process it in the 
normal way. 
 

********************************************************************* 
 

The TRIUS SX-825 guider port 
 
The TRIUS SX-825 is provided with a guide port for use with ST4 compatible mounts. The Autoguider 
output port is a 6 way RJ11 socket, which is compatible with the standard autoguider input of most 
telescope mounts. It provides 4 active-low opto-isolator outputs and a common return line, capable of 
sinking a minimum of 5mA per output. This socket may be used for telescope control if the TRIUS 
SX-825 is employed as an autoguider. 
 

 
 

 
 

********************************************************************* 
 



Handbook for the TRIUS SX-825      Issue 1 January 2015 
 

 19 

Camera maintenance: 

Very little maintenance is needed to keep the TRIUS SX-825 in excellent operating order, however two 
problems, which are common to all CCD equipment, might show up on occasion. These are dust and 
condensation. 

Removing Dust: 

1) Dust can be deposited on either the optical window (not a big problem to cure), or on the CCD 
faceplate (very difficult to eliminate entirely). When small particles collect on the window they may 
not be noticed at all on deep sky (small F ratio) images, as they will be very much out of focus. 
However, if a powerful contrast boost of the image is carried out, they may well begin to show as the 
shadow ‘Do-nuts’ mentioned earlier. Images taken with a large F ratio optical system are more likely to 
be affected by such dirt, owing to the smaller and sharper shadows that they cast. A light polluted sky 
will also make these marks much more obvious. There is no great difficulty in removing such particles 
on the outside surface by the careful use of a lens cleaning cloth, ‘lens pen’, or ‘air duster’ and so you 
should have little trouble with this aspect of maintenance. Dust on the CCD faceplate is a much greater 
nuisance, as it casts very sharply defined and dark shadows and it entails dismantling the camera to get 
rid of it! To clean the CCD you will need a good quality lens cloth (no silicone) or tissues and some 
high-grade acetone or isopropyl alcohol. A very suitable cloth is the ‘Micro-Fibre’ type marketed by 
PENTAX etc., and suitable alcohol is available from Maplin or Radio Shack etc. as tape head cleaning 
fluid. Most pharmacist shops will have small bottles of pure acetone. A bright light and a strong 
watchmakers eyeglass will also be found to be essential. 

Procedure: 

1) Disconnect the lead from the camera head and remove it from the telescope. Place it on a table with 
the optical window facing downward. 

2) Remove the two M3 screws and the M8 nut from the camera back plate and ease the plate out of the 
camera body. Unplug the fan lead from the camera PCB. 

3) Withdraw the body cylinder and unscrew the two top spacer pillars from the PCB. Now gently lift 
the PCB off the 20 way connector NOTING THE ORIENTATION OF THE BOARD for correct 
replacement later. Now remove the lower two spacers from the heat sink plate assembly. 

4) The camera heat sink assembly can now be lifted away from the camera front barrel and the CCD 
will be exposed. Note that a layer of white heat-sink compound is applied to the periphery of the heat 
sink disc and this should be left undisturbed by subsequent operations. 

5) You can now closely examine the CCD faceplate under the spotlight using the watchmaker's glass 
when any dust motes will show clearly. If there is only an odd particle or two and the CCD is otherwise 
clean, carefully brush away the dust with a corner of your lens cloth. A smeared or very dusty CCD 
will need a few drops of alcohol to clean thoroughly and you may have to make several attempts before 
the surface is free of contamination. One gentle wipe from one end to the other, with no return stroke, 
will be found to be the most effective action. DO NOT rub vigorously and be very careful to avoid 
scratching the window. 

6) Before re-assembly, make certain that the inside surface of the front window is also clean, and then 
carefully replace the camera front barrel and screw it into place. (If the heat sink seal is disturbed, 
renew it with fresh compound before reassembling). 

7) Replace all the camera parts in reverse order and the job is done. 

 

Dealing with condensation: 

The TRIUS SX-825 is designed to avoid condensation by minimising the volume of gas trapped within 
the CCD cavity and by preventing moisture ingress. This normally works very well, but storage of the 
camera in a humid location can lead to the trapped argon becoming moist by diffusion through the 
optical window mounting thread etc. and can result in condensation on the CCD window. If this 
becomes a problem, try storing the camera in a warm, dry place, or in a plastic lunch box containing a 
sachet of silica gel desiccant. If this is not effective, it is possible to flush the CCD chamber with dry 
argon from a small welding gas cylinder. Such argon gas cylinders, valves and suitable plastic tubing, 
are readily available from many car spares suppliers, such as Halfords, in the UK.Two ports are 
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provided in the sides of the CCD cavity and these may be accessed by unscrewing the rear plate of the 
camera and then sliding off the main barrel.  

 
The ports are sealed by M4 stainless set-screws and soft plugs, which may be removed to provide 
access to the chamber gas fill. You will need to make some kind of nozzle to fit the gas ports, but 
simply tapering the end of the standard 4 mm plastic gas tubing that is used with small welding bottles, 
will probably be sufficient. To recharge the chamber, first remove both gas plugs and then insert the 
tapered end of the argon cylinder tube into one port. Gently turn on the argon supply for about 10 
seconds and then refit the plug into the output port. The filling tube may then be extracted and the 
second port re-sealed. 

N.B. DO NOT leave the camera switched on for long periods between uses. The cold CCD will 
collect ice by slow diffusion through any small leaks and this will become corrosive water on the 
cooler and CCD pins when the power is removed. If substantial amounts of moisture are seen, 
dismantle the camera and dry it thoroughly. 

 

********************************************************************* 

Alternative Software 

Although we hope that you will be satisfied with our ‘SXV_hmf_usb’ software, other companies are 
offering alternative programs with more powerful processing functions. One of these is programs is 
‘AstroArt’ by MSB software. You can purchase AstroArt from many dealers Worldwide and more 
information may be obtained from their web site at http://www.msb-astroart.com 

‘Maxim DL’ is another popular choice and you can find out more by visiting 
http://www.cyanogen.com 

‘Nebulosity 3’ also works very well with the SX-825.  

http://www.stark-labs.com/nebulosity.html 

********************************************************************* 
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Some details of the camera and CCD characteristics 
 
The TRIUS SX-825 uses a Sony ICX825AL ‘EXview II’ progressive scan CCD, with 1392 x 1040 x 
6.45uM pixels in a 8.8 x 6.63mm active area. This EXview II device 
 
CCD type: Sony ICX825AL EXview II interline imager. 
 
CCD size: Active area 8.8 mm x 6.63 mm 
 
CCD pixels: 1392 x 1040 pixel array. Each pixel is 6.54 x 6.54uM square 
 
Well depth: Full res. mode 23,000e. Binned 2x2 mode approx. 25,000e 
 
Mean visual QE:  55%, 77% at peak (580nM) 
 
Useful spectral response: 360nM – 1100nM 
 
Readout noise:  Approx. 5e RMS typical, 8e max. 
 
Back focal distance: The CCD is approximately 17.5mm from the barrel front. 
 
Camera size: 75mm diameter x 70mm long 
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 Dear Observer, 

Thank you for purchasing a Starlight Xpress CCD Imaging System. We are confident that you will gain 
much satisfaction from this equipment, but please read carefully the accompanying instruction manual 
to ensure that you achieve the best performance that is capable of providing. 

As with most sophisticated equipment a certain amount of routine maintenance is necessary to keep the 
equipment operating at its optimum performance. The maintenance has been kept to a minimum, and is 
fully described in the manual. 

In the unfortunate instance when the equipment does not perform as expected might we recommend 
that you first study the fault finding information supplied. If this does not remedy the problem, then 
contact Starlight Xpress for further advice. Our message board service on the Starlight Xpress web site 
will often provide solutions to any problems. 

The equipment is covered by a 12-month guarantee covering faulty design, material or workmanship in 
addition to any statutory Consumer Rights of Purchasers. 

CONDITIONS OF GUARANTEE 

1) The equipment shall only be used for normal purposes described in the standard operating 
instructions, and within the relevant safety standards of the country where the equipment is used. 

2) Repairs under guarantee will be free of charge providing proof of purchase is produced, and that the 
equipment is returned to the Service Agent at the Purchaser’s expense and risk, and that the equipment 
proves to be defective. 

3) The guarantee shall not apply to equipment damaged by fire, accident, wear an tear, misuse, 
unauthorised repairs, or modified in any way whatsoever, or damage suffered in transit to or from the 
Purchaser. 

4) The Purchaser’s sole and exclusive rights under this guarantee is for repair, or at our discretion the 
replacement of the equipment or any part thereof, and no remedy to consequential loss or damage 
whatsoever. 

5) This guarantee shall not apply to components that have a naturally limited life. 

6) Starlight Xpress’s decision in all matters is final, and any faulty component which has been replaced 
will become the property of Starlight Xpress Ltd. 

 

For further info. or advice, please call: 

Mr Michael Hattey, 

Starlight Xpress Ltd., 

Unit 3, Brooklands Business Park, 

Bottle Lane, 

Binfield 

Berkshire, 

England.  RG42 5QX 

Tel: 01184026898 

Email: michael.hattey@starlight-xpress.co.uk  

Web site: www.sxccd.com  

 

 
 


